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Minstrel Wireless Modem Accessory Quick Start Guide

The Minstrel Wireless Modem Accessory provides wireless Internet connectivity for your HP Jornada 540 Pocket PC.  In order 
to set up your Minstrel to access the Internet, follow the steps below.

STEP 1 

Connect the Jornada to your desktop computer using the communications software included with the Jornada.  For information 
on how to do this, refer to the documentation supplied with the Jornada.

STEP 2

Start the software installation by clicking Minstrel Modem Manager on the main window of the software installation program.  
If the installation program is not running, make sure that the Minstrel CD is inserted into your CD-ROM drive and double click 
on My Computer on your desktop.  Then, double-click on your CD-ROM drive and then the Autorun.exe program.

STEP 3

Following the instructions given by the installation program.  The Minstrel software will automatically be installed to your 
Jornada once the desktop setup is complete.

STEP 4

When the installation is complete, disconnect your Jornada from the desktop computer and attach the Minstrel wireless 
modem to the Jornada.

To attach the Minstrel to the Jornada, position the devices so the front of the Minstrel is facing the back of the Jornada.  Slide 
the Jornada down past the Minstrel's latch so that the two connectors of the Minstrel meet with the connector slots on the 
bottom edge of the Jornada. Then, lift up on the latch on the top of the Minstrel and slide the Jornada underneath it to secure 
the Jornada in place. 

STEP 5

Set up an account with a Wireless IP service provider in your area.  You will need to provide the EID number found on the back 
of the Minstrel and record the network information you are given when setting up the account.

STEP 6

Start the Configuration Wizard to configure your Minstrel.  To start this program, select Programs from the Start menu on 
your Jornada.  Then, locate the Modem Manager icon from the main window and tap it to start the Modem Manager 
program.  The Modem Manager software will indicate that the modem has not yet been configured.  When prompted, choose 
to start the Configuration Wizard program.   If the modem has previously been configured and you are not prompted, select 
Configuration Wizard from the File menu.

For information on the Configuration Wizard program, refer to the documentation included with the program by selecting Help 
from the Start menu found in the top left corner of the window.

STEP 7

Once the configuration has been complete successfully, start the Modem Manager to register your wireless modem to the 
Wireless IP network.  In order to send and receive data across the Internet, the Minstrel must be registered to this network.

To start the Modem Manager program, select Programs from the Start menu on your Jornada and tap the icon labeled 
Modem Manager.  For information on the Modem Manager software, refer to the documentation included with the program by 
selecting Help from the Help menu found at the bottom of the window.

STEP 8

Click on the Status tab and wait for the Modem Ready check box to be checked.  This indicates that your modem is registered 
to the network and is therefore ready to transmit and receive data.   Also, the service LED found at the bottom of the Minstrel 
will be solid green when registration is successful.



STEP 9

If you wish to use Internet Explorer to browse the web, start Internet Explorer and then select Options… from the Tools 
menu.  Move to the Connections tab and select Minstrel from the Type list.  Click OK.  To connect to the Internet in the 
future, just start Internet Explorer as the Minstrel will automatically register to the network.

If there are other Internet applications you wish to use on your Jornada, please consult the document provided with the 
application to determine how to set it up for use with the Minstrel.

CONGRATULATIONS

You are now ready to access the Internet using your Minstrel wireless modem accessory.

For more information about your Minstrel wireless modem, select Novatel Minstrel Modem from the main Help listing on your 
Jornada. 

CUSTOMER FEEDBACK AND SUPPORT

For software updates and to provide feedback on the beta field trial, or if you have any problems setting up your Minstrel 
wireless modem, please contact Novatel Wireless Customer Support. 

WWW: www.novatelwireless.com/support/index.html
Phone: 1-888-888-9231 
Email: support@novatelwireless.com 
Fax: 1-888-812-2888

NOTICE TO USERS

This device has not been authorized as required by the rules of the Federal Communications Commission. This device is not, 
and may not be, offered for sale or lease, or sold or leased, until authorization is obtained. 

01016914

Version B
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Previous | Main | Next
Introduction to Configuration Wizard

Configuration Wizard is designed to guide you step-by-step through the configuration of your wireless modem. The 
configuration process includes the following:

Selecting a Wireless IP Service Provider
Gathering the Network Information
Entering the Network Addresses
Reviewing and Saving the Configuration
Configuration Saved
Registration Check
Registration Successful

In order to configure your modem to allow access to the Internet, you will be required to set up an account with a 
Wireless IP service provider. You may find it more convenient to acquire a subscription before running 
Configuration Wizard. You can then re-run the program at a later date after your service provider has activated your 
account.

Starting Configuration Wizard
Previous | Main | Next

Starting Configuration Wizard

To start the Configuration Wizard program, select Programs from the Start menu. Then, tap the icon labeled 
Modem Manager in the main window.

If the modem has not been configured previously, when Modem Manager tries to connect to the network, a message 
box will open with a button to start Configuration Wizard. Click this button. 

If the modem has previously been configured, select Configuration Wizard from the File menu once Modem 
Manager has started.

The first screen of Configuration Wizard gives information on the steps involved in the configuration of your 
wireless modem.

To begin with the first step in the configuration, click Next in the Configuration Wizard window.
Previous | Main | Next

Selecting a Wireless IP Service Provider

To be able to connect to the Internet using your wireless modem, an account with a Wireless IP service provider is 
required. Setting the service provider you have chosen is the first step in the configuration process.

To set the service provider, select the provider's name from the list given on the second page of the Configuration 
Wizard program. If the provider you wish to use is not listed, select Other.

Once the provider has been selected, click Next to advance to the next step in the configuration.
Previous | Main | Next

Gathering the Network Information
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The second step of the wireless modem configuration involves contacting the service provider to obtain the network 
information required to connect to the Internet. The third page of the Configuration Wizard program displays the 
contact information for the selected service provider and the modem's Equipment Identifier (EID).

You will need to provide the EID to the service provider when setting up an account. Once your account is set up, 
your service provider will give you the network information required to continue the configuration process. Please 
keep a permanent record of this and any other information provided as it may be required later for activities such as 
setting up e-mail.

To advance to the next step in the configuration, click Next in the Configuration Wizard window.
Previous | Main | Next

Entering the Network Addresses

In the third step of the configuration, you will need to enter the network addresses required to connect to the Internet. 
These addresses are provided by your service provider when your account is established and are described below. 

Note that it is very important to enter these numbers exactly as your service provider specified.

IP Address
The IP address is used in the Wireless IP network in the same way as a desktop computer's IP address. This set 
of numbers is used to identify a node or access point on the Internet. It is used like a telephone number, as one 
device may contact another device if it knows its IP number.

Primary DNS Address
The Primary DNS address is the first address used to access a Domain Name Server, which converts URLs or 
text based Internet Identifiers to numerical IP addresses.

Secondary DNS Address
The Secondary DNS address is used to access a Domain Name Server when the primary DNS is unavailable. 

Previous | Main | Next
Reviewing and Saving the Configuration

The fourth screen of the Configuration Wizard program displays the information entered in the previous steps.

To change any of these settings, click Back until you reach the appropriate window. Once the settings shown are 
correct, click Next to save them to the wireless modem.

Previous | Main | Next
Configuration Saved

The fifth screen of the Configuration Wizard program confirms that the settings were successfully saved.

You will now have to wait until your account is activated. The amount of time this will take should have been 
indicated by your service provider when the account was set up. After you have waited for the specified amount of 
time, click Next to proceed with the modem registration check.

Previous | Main | Next
Registration Check

In this step, the wireless modem will attempt to register to the Wireless IP network. The Configuration Wizard
displays the following check boxes to show the status of registration.

Cellular Signal Present
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This field is checked when there is adequate signal strength in order to communicate with the base station.

Wireless IP Service Detected
This field indicates whether or not there is Wireless IP service available in your area.

Modem Ready
This field shows that your modem has successfully registered on the Wireless IP network. 

The bar graph at the bottom of the screen represents a timer that shows how much time the registration attempt is 
taking. If your modem does not register by the time the bar graph is filled, a dialog will open, giving notes on 
possible solutions to the problem.

Once registration has been completed, with all three of the fields listed above checked off, the Configuration 
Wizard will automatically advance to the next screen.

Previous | Main | Next
Registration Successful

This step confirms that your Wireless IP modem has successfully registered with your service provider and that it is 
able to operate with the network addresses you have specified. It also provides information on how to connect to the 
Internet using your wireless modem.

To exit the Configuration Wizard, click Finish.

Notes

You do not have to run the Configuration Wizard again unless you change service provider, or you want to verify 
registration and your DNS addresses. In the future, you should use Modem Manager to make your Internet 
connection, and then run your own Internet applications.

Main
Troubleshooting Configuration Wizard

The following is a list of common error messages that may appear during the operation of Configuration Wizard. 
Click on the link for a description of the error and information on how to correct it.

EID Failure
Low Signal
Not Able to Register
Connect Failure

If the problems persist after trying the suggested changes, please contact Customer Support.
Troubleshooting

EID Failure

An EID failure will occur when the Configuration Wizard program cannot find the EID of your wireless modem. 
This error will prevent the modem from being configured. 

Try resetting the Pocket PC device. This will insure that the error is not due to a communication error between the 
Pocket PC and the wireless modem.

Troubleshooting
Low Signal

A low signal error message will appear if your wireless modem attempts to register but the signal strength from the 
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service provider is not strong enough to be received or cannot be fully received because of the location of the 
antenna on your modem.

Relocate your wireless modem for better reception. If this does not solve the problem you may be in an area where 
you are too far from a service provider's transmitter. You will have to relocate closer to the transmitter to achieve the 
minimum signal strength required to register the modem onto the network.

Troubleshooting
Not Able to Register

If your wireless modem was not able to register with your service provider for some reason other than low signal 
strength, this error will appear. Not being able to register may be due to one of the following reasons: 

l Your service provider may not have set up the account yet. 
l You may have entered one of the modem configuration parameters incorrectly. 
l Your service provider may not have set up the account correctly. 

If you have waited the required time for the Wireless Internet Provider to set up your account, verify the settings you 
have entered into your modem, particularly the IP address. If this number is not correct, your modem will not be able 
to register. If this number is valid and your modem still cannot register, contact your service provider to confirm 
your account status and the parameters you entered. Also check that you have Wireless IP service with adequate 
signal strength in your area.

Troubleshooting
Connect Failure

A connection failure message appears if a problem was encountered when retrieving status information from the 
wireless modem. Ensure that the wireless modem is securely attached to the host device and then reset the host 
device and try the operation again.

Previous | Main | Next
Introduction to Modem Manager

The Modem Manager software allows you to register your wireless modem to the Wireless IP network and view the 
status of the registration. The modem automatically attempts to register when Modem Manager is first started. The 
software also allows you to change the modem's settings and then save the changes.

The sections shown below describe the Modem Manager interface.

Menu Bar
Config Tab
Status Tab
Advanced Tab

Starting Modem Manager
Previous | Main | Next

Starting Modem Manager

To start the Modem Manager program, select Programs from the Start menu. Then, locate the icon labeled 
Modem Manager in the main window. Tap this icon to start the program.

When Modem Manager is first started, the wireless modem will automatically attempt to register to the Wireless IP
network.

Previous | Main | Next
Menu Bar



Novatel Minstrel Modem Help Page 6 of 15

file://C:\WINDOWS\TEMP\User Guide.htm 05/09/00

At the bottom of the Modem Manager window there is a menu bar that can be used to send commands to the 
modem or to find out more information about the wireless modem and its software. The commands provided in 
these menus are listed below, with links to a description of what the command does.

File Menu
Configuration Wizard
Save Settings to Modem
Disconnect and Exit
Shutdown Modem and Exit

Device Menu
Modem Information

Help Menu
Help
About Modem Manager

Menu Bar
Configuration Wizard

When you select Configuration Wizard from the File menu, the Configuration Wizard program is started.
Menu Bar

Save Settings to Modem

Selecting the Save Settings to Modem command from the File menu saves any changes that you have made in any 
of the Modem Manager tabs to your wireless modem.

Menu Bar
Disconnect and Exit

Select Disconnect and Exit from the File menu to close the active communication session and exit Modem 
Manager. Any applications that were connected to the Internet will have their connection terminated. The modem 
remains on however, allowing for "Push" messages to be received.

Menu Bar
Shutdown Modem and Exit

Selecting Shutdown Modem and Exit from the File menu closes any active communication sessions and shuts 
down the modem completely. Any applications that were connected to the Internet will have their connection 
terminated.

Menu Bar
Modem Information

When you select Modem Information from the Device menu, information about your wireless modem is displayed, 
including the name of the manufacturer, the modem EID number, model number, and firmware revision and date. 
This information is useful in the event you need to contact Customer Support or your service provider to request 
support for your modem.

Menu Bar
About Modem Manager

When the About Modem Manager command is selected from the Help menu, information about the Modem 
Manager software you have installed is displayed. This includes the version and date of the software and contact 
information for Customer Support.

Menu Bar
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Help

Selecting the Help command from the Help menu displays the Help file for the Modem Manager software, which 
you are currently reading.

Previous | Main | Next
Config Tab

The Config tab of the Modem Manager software allows you to change some of the settings used to connect to your 
service provider. These settings are given to you by your service provider and were previously entered using 
Configuration Wizard.

If you relocate to an area where you need to access a different network, or where your current service provider does 
not provide service or a roaming agreement (similar to cellular telephone roaming agreements), you will need to 
have a new Wireless IP account set up. This tab allows you to enter these new settings. Alternatively, you can run 
Configuration Wizard again to step you through the configuration process.

Please note that changing these settings will clear the authentication parameters that are stored in your wireless 
modem. Even if you restore these settings back to their original state by re-entering the original configuration 
information, your modem will no longer register. You will have to contact your serivce provider and have them reset 
your authentication. This is a security feature to prevent other people from using your Wireless IP account.

A list of the fields shown in the Config tab is given below with links to information about the parameter.

IP Address
DNS Address 1
DNS Address 2
Equipment ID
Cellular Signal Present
Wireless IP Service Detected
Modem Ready
Preference
Prefer to Use The Wireless Internet Provider
Use This Wireless Internet Provider Only

Config Tab
IP Address

The IP address is assigned by the service provider and is used to identify the wireless modem. Used similar to a 
telephone number, one device may contact another device if it knows the IP address. Do not edit this field unless 
instructed, as doing so will reset the registration credentials.

Config Tab
DNS Address 1

This field shows the settings for the Primary Domain Name Server. The DNS is an Internet based (accessible) 
computer system used to convert a URL or text based Internet Identifier to a numerical IP address.

Config Tab
DNS Address 2

This field shows the settings for the Secondary Domain Name Server. The DNS is an Internet based (accessible) 
computer system used to convert a URL or text based Internet Identifier to a numerical IP address. The Secondary 
Domain Name Server is the second choice used when the Primary Domain Name Server is unavailable.

Config Tab
Equipment ID
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The Equipment ID field shows the EID number of your wireless modem. This value should not be changed unless 
you are instructed to do so by Customer Support.

Config Tab
Cellular Signal Present

This field indicates whether or not the wireless modem has found a cellular channel on which it is able to send and 
receive information to and from the Internet.

Config Tab
Wireless IP Service Detected

When the box is checked, it indicates the presence of a wireless service which the modem can use. This may not 
necessarily be the service provider with which you have a subscription, but shows that there is Wireless IP service 
available at your current location.

Config Tab
Modem Ready

The Modem Ready status indicator shows whether or not the Modem Manager software can communicate with the 
wireless modem and that the modem has successfully registered onto the network. When this field is checked, you 
are now connected to the Internet and your modem is ready to send and receive data.

Config Tab
Preference

The Preference drop-down list box allows you to select from different service providers. If you are moving to 
locations where Wireless IP service is provided by different service providers who offer roaming agreements on 
their networks, or if you have separate subscriptions for different locations, you can chose the provider you want to 
connect to from the list.

If you chose Other as your preference, you will have to enter the SPI for the service provider you wish to use in the 
Advanced tab.

Config Tab
Prefer to Use This Wireless Internet Provider

Select this option to have the wireless modem use the service provider chosen in the Preference field as the preferred 
service provider. This means that the modem is also allowed to use any other service provider that it can find if your 
preference is not available. 

The preferred service provider does not have to be the same provider that you have a subscription with. This feature 
allows you to select a preferred service provider when you are roaming outside the area of your usual provider.

Config Tab
Use This Wireless Internet Provider Only

Select this option to force your wireless modem to only use the service provider chosen in the Preference field. This 
prevents the modem from roaming on any other service provider's channels and/or networks. You would choose to 
do this to prevent roaming on other channels to save costs on roaming agreements, for security reasons, or to ensure 
adequate network performance.

Previous | Main | Next
Status Tab

The Modem Manager software can be used to monitor and the current state of your wireless modem using the 
Status tab. This tab displays the fields listed below. For more information on the field, click on the link provided.

Signal Strength
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RSSI
Error Detect
System Busy
TX
RX
Provider
RF Channel
Registration Error

Status Tab
Signal Strength

The strength of the signal being received from the Wireless IP network is displayed here as a series of boxes. 
Typically, if at least half of the boxes are filled, the signal is considered to be good. If less than a quarter of the 
boxes are filled, the signal is weak and you may encounter delays in data transmission.

Status Tab
RSSI

This field provides a numerical value for the received signal strength. Modem operation is most reliable when the 
signal strength is greater than -100dBm.

Status Tab
Error Detect

The Error Detect indicator will flash if an error is encountered in data transmission or reception.
Status Tab

System Busy

The System Busy indicator will flash when the Wireless IP network is busy. The cause is normally too many users 
on the network. You may notice a decline in the performance of sending and receiving data.

Status Tab
TX

The TX indicator will flash when the modem is transmitting data.
Status Tab

RX

The RX indicator will flash when the modem is receiving data.
Status Tab

Provider

This field will display the name of the service provider's network that you are currently connected to. Because of 
roaming agreements between providers, if you are travelling between service areas the name that appears in this field 
may not be the name of the provider with whom you have an account.

Status Tab
RF Channel

This field shows the number of the CDPD channel which you are currently using.
Status Tab

Registration Error

This field will display an error message if your modem encounters an error in attempting to connect to the network 
or while connected. For information on possible errors and how to correct them, refer to the Troubleshooting 
Modem Manager.
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Previous | Main | Next
Advanced Tab

The Advanced tab allows you to configure more advanced settings for your wireless modem. It includes the 
following fields. To find more information about setting the field, tap on the link.

Service ID
SPI
SPNI
WASI
CDPD Version
Restore Defaults
Sleep Mode
Auto Power Off
Provider Side

Advanced Tab
Service ID

The fields in the Service ID box show the identifier numbers associated with the service providers. For more 
information about these fields, click on one of the links below. 

SPI
SPNI
WASI

Advanced Tab
SPI

The SPI is an identifier for a CDPD carrier or Wireless IP service provider and is called the Service Provider 
Identifier. This number is used globally for each specific service provider.

Advanced Tab
SPNI

The SPNI is the Service Provider Network Identifier, which is used to identify a specific network region or domain 
for a service provider.

Advanced Tab
WASI

The WASI field displays the unique identifier used for a group of service providers that have agreed to provide 
service over a large geographic area comprising many SPNIs.

Advanced Tab
CDPD Version

This field displays the version of CDPD or Wireless IP technology that your wireless modem is using. Most service 
providers use CDPD Version 1.1. You should not change this setting unless directed to do so by your service 
provider.

Advanced Tab
Restore Defaults

Pressing the Restore Defaults button will write over some of the current settings with the factory defaults. The 
parameters will be reset as follows:

l Preference is changed to Any
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l CDPD Version is changed to 1.1
l Provider Side is changed to A preferred
l Sleep Mode is Disabled
l Auto Power Off is Disabled

All of the settings not listed here are not changed.
Advanced Tab

Sleep Mode

Sleep mode is a power saving mode where the wireless modem periodically powers down to its minimum power 
consumption state while still maintaining a connection to the host device and a periodic link to the CDPD network. 
The host device may wake the modem at any time, while the network will wake it at a predetermined time if there is 
data to be sent to it. You can choose to either Enable or Disable sleep mode by using the pull-down list.

Advanced Tab
Auto Power Off

Enabling the Auto Power Off setting means that the wireless modem will power off when your network connection 
is terminated. The connection will be terminated if you use either the Disconnect and Exit or Shutdown Modem and 
Exit command from the File menu.

Advanced Tab
Provider Side

The Provider Side field indicates the network channel side that the wireless modem is currently operating on. 
Cellular systems have two sides, which are labeled A and B. Normally, you should operate the modem on either A 
Preferred or B Preferred as recommended by your service rovider.

Main
Troubleshooting Modem Manager

Errors encountered during registration to the Wireless IP network will either be displayed in the Registration Error
box of the Status tab or in a separate window. The following is a list of error messages that may appear with links to 
suggestions on correct the error.

Error connecting to the wireless modem
Unable to read settings
Modem not connected and changes not saved
Modem not connected and cannot shut down
Networking session disconnected

If the problem persists after trying the suggested changes, please contact 
Troubleshooting

"Could not connect to the wireless modem. If the problem persists, reinstall the software and retry the 
operation."

This message indicates that a problem with the support services of the Pocket PC operating system was encountered 
during initialization of the networking connection with the modem. Try removing the wireless modem software and 
reinstalling.

Troubleshooting
"Not able to read settings from modem. Reinsert device into cradle and retry."

During application initialization the modem manager will attempt to read information from the modem. If it cannot 
do this the error message above will appear. If the wireless modem is a separate accessory from the host device, 
there may be a problem with the physical connection of the device to the modem cradle. Try removing the wireless 
modem from the Pocket PC and then re-attaching it.
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Troubleshooting
"Wireless modem is not connected. Changes not saved!"

If you have selected to save the settings to the modem, this message will appear if the cradle is not attached or there 
is some problem in communicating with the cradle. Try exiting the Modem Manager software and restarting it.

Troubleshooting
"Wireless modem is not connected. Cannot shut down!"

This error indicates that you have selected to shutdown the Modem Manager but the cradle is not attached or there 
is some problem in communicating with the cradle. Try exiting the Modem Manager software and restarting it.

Troubleshooting
"Networking session with your Wireless Modem has been disconnected. Do you want to try and reestablish 
the connection?"

This message indicates that the Pocket PC device has been powered off manually or allowed to power off through 
the idle timer while a networking session with the modem was active. This causes the networking session to close. 
To re-establish the session, click OK.
Equipment Identifier

Every wireless IP modem manufactured has a unique serial number associated with it, which is refered to as the 
Equipment Identifier or EID. Each EID consists of six sets of two hexadecimal numbers that are often separated by a 
period ("."), as in the sample EID 00.60.D6.04.BC.FE.

The EID of the modem can be found on a label on the back of the modem or through the Configuration Wizard and 
Modem Manager software.
Wireless IP

Wireless IP, which is also called Cellular Digital Packet Data (CDPD), is a wireless data transmission technology 
that uses unused cellular channels to transmit packets of data. To send and receive data across the Internet, a CDPD 
or Wireless IP modem must first register to the Wireless IP network.
Registration

In order to send and receive data across the Internet, a Wireless IP modem must first register to the Wireless IP 
network. This involves selection of an appropriate channel to use and the exchange of authentication parameters 
with the CDPD network to set up a path for communication.

This electronic registration process also includes measuring a variety of network parameters to ensure a minimum 
level of capability for successful operation of your modem. Registration is done automatically every time the modem 
is powered on.

Notes

When your Wireless Modem attempts to register onto the network, it will search for service on channels that it has 
previously registered to. If you have relocated to a new CDPD coverage location, the modem will may not find a 
channel in this list and, consequently, it will begin a search for a new channel. This will cause a noticeable delay in 
registration as the modem must search for all the channels on its list and then search for a new channel.

Previous | Main | Next
Features and Requirements

The Minstrel 540 modem provides wireless Internet connectivity for the HP Jornada 540 Pocket PC using Wireless 
IP technology.

Features
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The Minstrel 540 has the following features:

l CDPD Specification 1.1 
l Data transmission speeds of up to 19.2 kbps 
l Built in TCP/IP, UDP, PPP and SLIP protocols 
l 0.6 Watt RF power output 
l Attaches to the Jornada to create a single, integrated unit 
l Rechargeable Lithium-Ion battery (technician-replaceable) 
l AC adapter included 
l LED indicators 

Requirements

The following is required to set up and configure the Minstrel 540:

l HP Jornada 540 Pocket PC 
l Desktop software that allows you to communicate between your Desktop PC and the Jornada 
l Modem application software for the Pocket PC (included with your Minstrel) 
l An account with a Wireless IP service provider in your area 
l Application software for your Pocket PC such as an e-mail client and web browser 

Wireless IP service is available from your local cellular carrier in most North American cities. Check your product 
packaging or www.novatelwireless.com for carrier contact information.

Caution

To satisfy FCC RF exposure compliance requirements for mobile transmitting devices, the user should generally 
maintain a separation distance of 20 cm between the person’s body, and the device and its antenna. The hands and 
wrists have a higher exposure limit because they are extremities, and the device should be used in a hand-held, hand-
operated configuration only.

This device has been tested for compliance with a separation distance of 4 cm from a person's body. The operating 
configurations of this device generally do not support normal transmissions while it is carried in pockets or holsters 
next to a person’s body.
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LEDs and Controls

The Minstrel 540 has both LED indicators and software that allow you to easily configure the modem or determine 
the status of various modem parameters.

Configuration Wizard Software
The Configuration Wizard is designed to guide the user through the configuration of the Minstrel in a step-by-step 
fashion.

Modem Manager Software
The Modem Manager software provides a simple interface for configuring the modem and determining the status of 
registration.

Service LED
The Service LED is found on the front of the Minstrel and is labeled with the icon shown below. 

When the modem is attempting to register, this LED will flash green. When the modem is registered, the LED will 
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be solid green. In sleep mode, the LED will be solid green mostly but will flash off occassionally.

Data/Message Waiting LED
The Data/Message Waiting LED can be identified by the icon below. 

This LED flashes green to indicate that data is being sent or received. When the LED flashes red, a "push" message 
is has been received by the modem. This LED will flash until the message is viewed.

Battery LED
The Battery LED is labeled with the following icon:

When this LED is flashing red, the battery is low and requires charging. If it is flashing green, the battery is being 
charged, and if it is solid green, the battery is fully charged and the AC adapter is powering the unit.
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Charging the Battery

The Minstrel 540 contains a rechargeable Lithium-ion battery. This battery is shipped only partially charged, so it is 
necessary to charge the battery to its full capacity before using the unit.

To charge the battery, plug the AC adapter that is supplied with the Minstrel into an outlet and insert the barrel 
connector into the DC jack found on the top edge of the Minstrel.

It will take approximately 3 hours to charge the battery from a zero charge state. With sleep mode enabled, the 
battery should provide power for the unit for a full day of web browsing under normal conditions.

When the Battery LED is flashing red, this indicates that the battery is low and requires charging. Note that if the 
battery charge goes lower than a pre-set threshold, the modem will automatically de-register and power off in order 
to preserve the settings in its internal memory.
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Attaching the Minstrel to the HP Jornada

The Minstrel 540 attaches to the Jornada to provide a single, integrated unit and uses the serial interface found on 
the bottom of the Jornada to communicate with it. In order to configure and use the Minstrel, you must attach the 
Minstrel to the Jornada as follows:

First, position the devices so the back of the Jornada is facing the front of the Minstrel. Slide the Jornada down past 
the Minstrel's latch so that the two connectors of the Minstrel meet with the connector slots on the bottom edge of 
the Jornada. Then, lift up on the latch on the top of the Minstrel and slide the Jornada underneath it to secure the 
Jornada in place.
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Configuring the Minstrel

In order to connect to the Internet, the Minstrel must first be configured with the necessary parameters to be able to 
register to the Wireless IP network.

To configure the Minstrel, attach the Minstrel to the Jornada and run the Configuration Wizard program. For more 
information on how to start this program, refer to Starting the Configuration Wizard.

Note that in order to configure and use the Minstrel, an account must first be established with a Wireless IP service 
provider.
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Connecting to the Internet
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To send and receive data across the Internet using the Minstrel, a connection to the Wireless IP network is required. 
To register to the network, run the Modem Manager program. For more information on how to start this program, 
refer to Starting Modem Manager.

Once the Minstrel is registered, you can set up and use any Internet application on your Pocket PC.

Using Pocket Internet Explorer

To view web pages using Pocket Internet Explorer, you must set up the Internet Explorer program to work with your 
Minstrel modem. To do this, start Pocket Internet Explorer and select Options... from the Tools menu. Select the 
Connections tab and select Minstrel from the Type list. The next time you start Pocket Internet Explorer, the 
Minstrel wireless modem will automatically register to the network, so it is not necessary to start the Modem 
Manager program first.

Main

Customer Feedback and Support

For software updates and to provide feedback on the beta field trial, or if you have any problems setting up your 
Minstrel 540, please contact Novatel Wireless Customer Support.

WWW: www.novatelwireless.com/
support/index.html 

Phone: 1-888-888-9231
Email: support@novatelwireless.com
Fax: 1-888-812-2888
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Notice to Users

To satisfy FCC RF exposure compliance requirements for mobile transmitting devices, the user should generally 
maintain a separation distance of 20 cm between the person’s body, and the device and its antenna. The hands and 
wrists have a higher exposure limit because they are extremities, and the device should be used in a hand-held, hand-
operated configuration only.

This device has been tested for compliance with a separation distance of 4 cm from a person's body. The operating 
configurations of this device generally do not support normal transmissions while it is carried in pockets or holsters 
next to a person’s body.
�


